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What is Unit Testing?

m A procedure to validate individual units of Source Code
m Example: A procedure, method or class

m Validating each individual piece reduces errors when
integrating the pieces together later
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Automated Unit Tests with JUnit

m Junit is a simple, open source unit testing framework for Java
m Allows you to write unit tests in Java using a simple interface

m Automated testing enables running and rerunning tests very
easily and quickly

m Supported by www.junit.org




JUnit Example

public class Calc

{ static public Int add (int a, Int b)
{
return a + b;
}
+

import org.junit.Test
import static org.junit._Assert.*;

public class CalcTest
{
@Test
public void testAdd()
{
int result = Calc.add(2,3);
asserteEquals( 5, result);

}




Basic Information

m Test Suit
m A collection of of test cases/classes executed together

m Test Class

m Named [classname]Test.java, where classname is the name of the
class that is tested.

m Test Method

m A test method can contain one or more test cases.
m Annotated with @Test to indicate them to Junit.
m Has one or more assert statements or fail statements.

m Test Case

m A test case is usually a single run of a specific functionality.
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Steps to perform unit tests (Junit)

1. Prepare (or setUp() ) environment conditions that must be
met, according to the test plan. At this stage, define and set
prefix values. E.g. instantiate objects, initialize fields, turn
on logging, etc.

2. Execute the test case. This means, executing (exercising)
the part of the code to be tested. For that we use some test
inputs (test case values), according to the test plan.

3. Evaluate (or assert*()) the results, or side effects
generated by the execution of the test case, against an
expected value as defined in the test plan.

4. Clean up (or tearDown()) the test environment if needed
so that further testing activities can be done, without being
influenced by the previous test cases. We deal here with
postfix values.
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Step 1: Unit Testing with JUnit 4

1. Prepare (or setUp() ) the test environment:

- Annotate with @Before: Those methods are executed before
each test case (test method).

@Before
public void setUp() {
s = new Sample();
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Step 2&3: Unit Testing with JUnit 4

2. Execute the test case.

3. Evaluate the results (using assertion).

@Test
public void testAddition( ) {
int a=3 , b=6;
int expectedOutput = (a+b);
InNnt res = s._Addition(a, b);
assertEquals(expectedOutput, res);



+
Step 4: Unit Testing with JUnit 4

4. Clean up (or tearDown()) the test environment is done in one
or several methods that are run after execution of each test
method.

= A method has to be annotated with @After.

m If you allocate external resources in a @Before method, you need
to release them after the test runs.

@QAfter
public void tearDown() {
s = null;


http://junit.sourceforge.net/javadoc/org/junit/Before.html

+

junit.framework.Assert

m Provide static methods which can help comparing the expec

result and actual result.

m [f any assert is violated, a failure will be recorded.

assertEquals (expected, actual)
assertSame (expected, actual)
assertNotSame (unexpected, actual)
assertFalse (condition)

assertTrue (condition)
assertNotNull (object)

assertNull (object)

fail ()

assertEquals (message, expected, actual)
assertSame (message, expected, actual)
assertNotSame (message, unexpected, actual)
assertFalse (message, condition)

assertTrue (message, condition)
assertNotNull (message, object)

assertNull (message, object)

fail (message)



Test Execution

m Execute a test by using the Run function of the
IDE.

m NetBeans/Eclipse, can use a default test runner--
all the tests in the class run one by one.



Status of a Test

m A test is a single run of a test method.

m Success

m A test succeeds in time when No assert is violated; No fail
statement is reached; No unexpected exception is thrown.

m Failure

m A test fails when an assert is violated or a fail statement is reached.

m Exrror

m An unexpected exception is thrown or timeout happens.



Status of a Test

m On failure and error, the test results also show a stack trace
of the execution.

Statistics | Output

-1 test passed, 1 I:esl:-lﬂﬂileclJ 1 kesk caused an error,
S-fify Code.CalculatorTest FAILED

> ------ @ testhdd passed (0.0 s)

L'_—_'IG testMultiply FAILED (0.016 s)

i The test case is a protoktype,

> ------ junit, framework, AssertionFailedError
E i at Code, CalculakorTest, bestMulkiplyl Calculakor Test, java: 77)
EI @ testDivide caused an ERRCR (0.0s)

...... { by zero

> ------ java.lang. ArithrmekicException

------ at Code, Calculakor, divided Calculator . java: 323

- at Code, Calculator Test, testDividel Calculator Test, java: 590




Test Suit

m To run a subset of the tests or run tests in a specific order.

m A test suite is basically a class with a method that invokes the
specified test cases, such as specific test classes, test
methods in test classes and other test suites.

m You can create manually or the IDE can generate the suites
for you.

m Example:

TestSuite suite= new TestSuite();
suite.addTest(new MathTest("testAdd"));
suite.addTest(new MathTest("testDivideByZero"));
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Junit with Netbeans

1. Create the Java Project

2. Create the Java Class

3. Create a Test Class for Java Class
4. Write Test Methods for Test Class
B. Run the Test

6. Create Test Suit (optional)



Junit with NetBeans
Lets Do The Code

m Make a simple class named (SimpleMath. java) that has the
following methods:

m Addition
m Subtraction

m Multiplication

m Create the test class for these method.



1. Create the Java Project

m Launch NetBeans

m File-> New Project

|

.00 New Project
Steps Choose Project
1. Choose Project Categories: Projects:
2. £ Java &» Java Application
1 JavaFx [~ Wjava Class Library
7 Maven &» Java Project with Existing Sources
G NetBeans Modules &Y Java Free-Form Project
» [ samples

Description:

Creates a new Java SE library in a standard IDE project. A Java SE library does not

contain a main class. Standard projects use an IDE-generated Ant build script o
build, run, and debug your project.

( Help ) < Back

(Next=+) [ Finish

( Cancel )
A



1. Create the Java Project

Steps MName and Location

1. Choose Project - . .

2. Name and Location Project Name: SimpleMath
Project Location:  /Users/macbookpro/NetBeansProjects (" Browse... )
Project Folder: [Users/macbookpro/NetBeansProjects /SimpleMath

|| Use Dedicated Folder for Storing Libraries
Libraries Folder: Browse...

Different users and projects can share the same
compilation libraries (see Help for details).




m File-> New File

600

2. Create the Java Class

New File

Steps

Choose File Type

1. Choose File Type
2.

Project: [ & SimpleMath

=

Categories: File Types:
o m |&] Java Class =
[ JavaFx |£] Java Interface
] swing GUI Forms % Java Enum
[] JavaBeans Objects B j::: ‘;:2;;::{')‘:}" Type
= AWT GUI Farms @ Java Package Info
£ Junit B JApplet
[ Persistence l& Applet
[ Hibernate Java Main Class
[ xmL &| Java Singleton Class S
3 other |£] Empty Java File E
2 1awa Parkane i
Description:

classes.

Creates a new plain Java class. This template is useful for creating new non-visual

Help < Back

(Mext>=) ( Finish

( Cancel )
A




2. Create the Java Class

1.
2.

Choose File Type
Mame and Location

Class Mame: SimpleMath

Project: SimpleMath
Location: | Source Packages 13
Package: ﬁ

Created File: 1acbookpro/NetBeansProjects/SimpleMath/src/SimpleMath.java

/%\Warning: It is highly recommended that you do NOT place Java classes in the defaull




2. Create the Java Class
SimpleMath.java

M NetBeans File Edit Navigate Source Refactor Run Debug Profile Team
06 NetBeans IDE 7.1.1

f_‘] % : _l—‘ [-r:defaultmnf...lﬁ E@ E@ -|> '@'

cjav @ LineTestjava @ Linejava = @] Quadrilateral java @ QuadrilateralTestjava E] Triangle @ Triani
iree| [ Hisory | [@ [@-8- 9 O SFIE N P B oE w0
l _.'1.-
2 * -Jjava
3 & Al -Duwais
4 * Lab Tuto
5 * Week#d
6 -
';f & |
8
9 package simplemath;
10
11
12 public class SimpleMath {
13
14 static public int add{int a, int b)
15 {
16 T return a + b;
17 }
18
19 static public int multiply { int a, int b)
20 {
21 T return a * b;
22 }
23
24 atatic public int subtract ( int a, int b)
25 {
26T return a / b;
27 }
28
29 }
| BT 1




3. Create a Test Class for Java Class

m Choose this menu in netbeans or from Right Click:

m Tools > Create Junit Test
m Or just simply press Ctrl + Shift + U.
m A window dialogue will appear, choose suitable options.

m Test case will automatically build inside the test package
folder.



3. Create a Test Class for Java Class

ARG

Refactor Run Debug Profile Team Window Help

@‘n“@ b Ep-Cp-

|=| SimpleMath - NetBeans IO

= df) E=us @I

Apply Diff Patch...
Diff
Add to Favorites

— .
Projects | Services Files | javq D QuadrllateraITutJava ® |E] Trlangle ||§‘| Triang Show In Finder Math java
» | Test Packages L :
- (sl Ubrares S [y | [0 (G- 4 Q% & Analyzelavadoc a a e
. . Create JUnit Tests :
» [& Test Libraries i et AL
v QBIUnrﬁample,SoI 2 (] _ae e
w [ Source Packages 2 Internationalization »
< U g&"u"t'f i z Java Platforms
ils.java
i 7 NetBeans Platforms
[ ®vectors.java a Variables
» [ Test Packages 9 package simplemath; Librari
» [ Libraries i? i ra.r||es
> E Test Libraries 12 public class SimpleMath { Tempates
v & SimpleMath 13 ] o ) ) DTDs and XML Schemas
v [ Source Packages i; static publiec int add{int a, int b) Palette »
v [ simplemath 18 T return a + b; .
Plugins
& SimpleMath.java i; | 9
v @ J—_EH Packages 19 static public int multiply ( int a, int b)
¥ || simplemath 20
|&] SimpleMathTestjava o T return a * b;

» (g Libraries
¥ [ Testlibraries

add - Navigatar

| EI
B B B
L B

[ Members View

25
26 T return a / b;

v &) SimpleMath
() add(int a, int b) : int
() multply(int a, int b) : int
() subtract(int a, int b) : int

static public int subtraect ( int a, int b)
{




3. Create a Test Class for Java Class

'aﬁo - Create Tests

Class to Test: simplemath.SimpleMath

Class Name: [ simplemath.SimpleMathTest ]

Location: [TESI’ Packages = !

Code Ceneration

Method Access Levels Generated Code
™ public M Test Initializer
E Protected E Test Finalizer
E Package Private E Default Method Bodies

Cenerated Comments
E Javadoc Comments

E Source Code Hints

( Help ) (Cancel) E 0K j
P



3. Create a Test Class for Java Class

L3 |_ |
14

15 public class SimpleMathTest |

16

17 T public SimpleMathTest () {

18 }

19

20 @BeforeClass

21 T public static volid setUpClass() throws Exception {
22|

23

24 @Afterclass

25 T public static void tearDPownClass() throws Exception {
26 }

27

28

29 T

30

31 @Test

32 public void testAdd() {

33 System.out.println{"hdd");

34 int a = 0;

35 int b = 0;

36 SimpleMath instance = new SimpleMath{};
37 int expResult = 0;

38 int result = instance.hdd{a, b);

39 assertFguals(expResult, result);

40

41 fail{"The test case is a prototype."}:
az L }

43

44

45 T

d6

47 @Tesat

48 public void testSubtract() {

49 System.cut.println{"Subtract”):



38
as
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
T2
73
T4
75

P

N 4. Write Test Methods for Test

Class

SimpleMathTest.Java

ETest

public void testAdd() {
System.out.println("add"”);
int a = 23
int b = 2;
int expResulkt = 4;
int result = SimpleMath.add({a, b);
assertEguals({expResult, result);

@Test

public vold testMultiply() {
System.out.println{"multiply"”);
int a = 1;
int b = 3;
int expResult = 3;

int result = SimpleMath.multiply(a, b);

assertEguals{expResult, result);

ETest

public void testSubtract() {
System.out.println{"subtract"”});
int a = 5;
int b = 1;
int expResult = 4;

int result = SimpleMath.subtract({a, b);

assertEguals|{expResult, result);




4. Write Test Methods for Test
Class

m Assign the variable value for the test case.
m Remove the fail() method in return valued method test.
m Run the test class using Shift + F6.

m See the test result
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5. Run the Test

Test Results | Output - SimpleMath (test) | Tasks |

[ SimpleMath |

4

W ' | ;g{;tiply
[:Ih 2 tests passed, 1 test failed.(0.196 s) subtract
""""" v /Y. simplemath.SimpleMathTest FAILED

' a ﬁ testAdd passed (0.003 s)

b ﬁ testMultiply passed (0.0 s)

a b /Y testSubtract FAILED: expected:<4> butwas: <5>

) )
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6. Create Test Suit

m Right-click the project node in the Projects window and
choose New > Other to open the New File wizard.

m Select the JUnit category and Test Suite. Click Next.
m Type SimpleMathTestSuit for the file name.

m Deselect Test Initializer and Test Finalizer. Click Finish.



6. Create Test Suit

4 ¥y ¥Y¥¥YY

g,l jﬂ\"ﬂi..ﬂl[ L 1 1 1 e —— —— : - g i e F
(58 junit-sample 50 E;;";‘";”I;"’““““" ToTTmEmE
&8 sJUnitsampleSol 51 int b = 1;

52 Math instance = new Math{);

&5 Math

53

int expResult = 0;
@ S“TIDIEMHI Sd int raanlt = inatanca. Suhérackia. h);
v [ Source I > i

b FH <de

¥ [ TestPa

B <de

» (= Librari

b (& Testli
&% Triangle

Build

Clean and Build
Clean

Cenerate Javadoc

Run
Debug
Profile

Test “Fb

Set Configuration

Set as Main Project
Open Required Projects

>

lode

L Jel¥el # el L

Jiw Test for Existing Class...

4w JUnit Test... lth.
& Java Interface... |
|_|JPanel Form...

= JFrame Form...

| Entity Class...

| Entity Classes from Database...

¥ Other... P
mmnde

=]
L=
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6. Create Test Suit

import org.
import org.
import org.
import org.

junit.
junit.
junit.
junit.

AfterClass;
BeforeClass;
runner . RunWith;
runners.Suite;

BRunWith|{B8uite.class)
BSuite.Suitelflasses{{SimpleMathTest
public class SimpleMathTestSuite [

@BeforeClass
public static void setUpClass() throws Exception {

}

ghfterClass
public static void tearDownClass() throws Exception {

}

.class})
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Junit Resources

m http://junit.sourceforge.net/

m http://code.google.com/p/t2framework/wiki/JUnitQuickTuto
rial

m http://netbeans.org/kb/docs/java/junit-intro.html



http://code.google.com/p/t2framework/wiki/JUnitQuickTutorial
http://code.google.com/p/t2framework/wiki/JUnitQuickTutorial
http://code.google.com/p/t2framework/wiki/JUnitQuickTutorial
http://code.google.com/p/t2framework/wiki/JUnitQuickTutorial
http://netbeans.org/kb/docs/java/junit-intro.html

Summary

m Unit tests can help test the details of your program

m Automated unit tests provide constant visibility and easy
retesting

During a defect causal analysis meeting...

"You may take my life, but you'll
never take my FREEDOMI!I"

-l
rtoontester.blogspot.com © 2012
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